Méthode compléte pour la création de cette figurine :

John Frogg

L =

Les étapes du tuto

Bonjour a tous,

Je m’appelle Bébert. Je suis un Festayre.

Vous ne connaissez pas ce terme ?

Pas compliqué, vous cherchez sur le Web et trés vite
vous allez tomber sur des gens comme moi qui ont le
sens de la féte !

Oui, par ici dans notre Sud-Ouest !

Venez, vous serez bien recus | Pampelune, Bayonne,
Dax, Mont-de-Marsan.

Vous avez un GPS ? Parfait ! On vous attend !

Oui, d’accord !
Parfois on est

« limites » |
Mais la féte c’est
la féte !

Pas vrai ? -

Revenons a moi ! Vous permettez ?
Je suis né de I'imagination d’Anthony.
Il souhaitait avoir un peu d’aide dans ma conception.

n’y échappe pas !
Et puis il s’est mis dans la téte de vouloir m’imprimer en « 3D ».

3D et qui savent prendre leur temps pour régler leur engin. La
plupart de ceux que je connais ont une « CR10 » ou une « CR10S ».
Et puis il y a ceux comme Anthony qui ont fabriqué le leur.

Le probléme d’Anthony : Comment me concevoir ? Une téte au carré ? Des extrusions ? En plusieurs
pieces ? Un bon logiciel en tout cas. Lequel ? « Fusion 360 ».

Et apres, on fait comment ? Echange de points de vue dans le groupe Facebook... -
Finalement, je suis né en plastique et sans os. Et je vais bien !

Maintenant, je suis fier de vous proposer ce tuto créé a l'intention de ceux qui veulent se former a
I"utilisation de « Fusion 360 ».

Pour le moment, il me connaissait bien par I'imagerie. Chez nous, on

Il a rejoint, sur Facebook, un groupe de « Printers » comme ils disent.
Non pas des sprinters | Des gens qui sont passionnés par I'impression



Comme le document est un peu long, on risque
de se perdre, de bricoler beaucoup a retrouver
le passage intéressant...

On s’est dit, avec Anthony, qu’il pouvait étre
judicieux de proposer une « Table des
matiéres ».

S .
/ Voila, c’est ici !

Comme je suis bavard, encore une remarque pour répondre a ceux qui
estiment qu’un tuto en « PDF » c’est « dépassé » : I
« Eh I'ami, aujourd’hui les tutos se font en vidéo ! ».

Moi, je réponds que je trouve énormément d’avantages aux tutos en PDF ou format Word. Vous
trouvez pratique de devoir fouiller dans les vidéos pour retrouver une séquence particuliére ? Sur
un document écrit, vous la retrouvez beaucoup plus vite, votre astuce géniale ou une technique
judicieuse....

Et tous ceux qui n’ont qu’un écran (Je pense a Anthony). IlIs font comment ? Alors qu’une
imprimante, ¢a imprime et on a un bout de papier bien utile !

Jarréte la mais les avantages, j’en connais d’autres....

Liste des séquences :

Ce tuto est complété par un autre PDF

A) Le corps. - disponible dans le groupe Facebook.

B)Le beret_' . Création des bras avec SCULPT.pdf
C) Le « haricot ».

D) Le bas du corps.

Je fournis également les images utilisées

E) Le bras droit. dans ce tuto.
F) Le bras gauche.
G) La ceinture. Ainsi que les éléments suivants
H) Les pieds. (Composants réutilisables dans la
[) Les jambes. Creatlo.n) : .
- Les mains (Les 3 versions).
J) Les jambes de pantalon. Les bras créés par SCULPT.
K) Mettre Ia ceinture de biais. Le nceud.
L) Le noceud.
M) Les yeux. Bientdt disponible dans les fichiers du ~
N) La bouche (2 techniques). groupe : -
O) Les mains « raideS ». 2 Fusion 360 - Préparation de Bébert pour |'impression.pdf | .
P) Les mains « courbes ». ‘ \° .

Q) Les mains « créées a partir d’'une image ».




A) Le corps :

IE& Sketch

Choisir de le faire sur le plan horizontal

B> @i

SKETCH
e co—

L4 Create Sketch
+2) Line
Rectangle

avec centre

/ Cet outil Cercle
\‘ @ Center Diameter Circle I C‘
>

@ 2-Point Circle

Il faut démarrer « sérieux » c’est-a-dire pas n’importe ou.
Utiliser le magnétisme du logiciel. On va en profiter par la suite.

A savoir : Quand on utilise un
outil. A la fin, touche "echap" du
clavier pour le quitter sinon on le
conserve sur le curseur souris.

Donc commencer a créer le cylindre en faisant un
cercle avec le centre parfaitement sur le centre

A savoir : Généralement, on commence une
création en imposant des « Contraintes » comme
les dimensions précises des éléments, etc...

Pas sur ce tuto, car on

Sélectionner le disque b Rl
Puis extrusion R x
(De type « New body ») Start b Profie Plane

Direction By one side

0.00 mm

Taper Ang! 0.0 deg

Operation (| New Body

ent H Distance \

crée une piece
« artistiqgue » pas une
- piece « technique ».

IS

D’un seul coté

LiJ Cancel Retour a la liste
B) Le béret :
Sélectionner la face du cylindre Plan (Ce plan est donc collé sur cette face)

Gﬂ% 2"

CONST

Sur le plan : Sketch



Sur le sketch faire un cercle parfaitement concentrique au précédent.

/

Extrusion (New body)

Nouveau Plan sur cette face. Puis relever le plan.

__— Puis relever le plan.

Retour a la liste

Sur ce plan / Sketch
Sur ce Sketch : Faire un petit cercle mais
concentrique aux précédents.

Puis « Stop Sketch »

N\

@

STOP SKETCH ~

Outil « Loft » et sélectionner les 2 cercles. |l crée cette jupe.
(Ci-dessous)



&6 Qlle

MODIFY
© EDITFEATURE
Loft
i oo Profiles
Creates a \vansitional shape between two or more
sketch proh'es or planar faces. Profiie 1 ﬂ:ﬂ p Connecied 5> Sé|ecti0nner un disque
Select ies of profil lanar f: to defi . . ; .
SHAGE Ol Srlect s e i ot o G ol >l RLCevoried ) — Sélectionner l'autre
the shape. + x disque
Guide Type @ %
Rails [R3
Je conseille de choisir
+ X .
_~ «New body » (Plus facile
Skt de le modifier ensuite)
Closed @
Operation I @ New Body' v

Outil « Filet » pour faire I'arrondi ici.

Retour a la liste

Mais on ne peut pas faire cet arrondi car ce
sont 2 bodies différents A et B.

Il faut d’abord les réunir en un seul.

4 9 [N

D &+ Document Settings
D EJ Named Views

4 Q £, Bodes,, Sélectionner ——

() Boay1 / les 2 bodies
\
=

Modify / Combine / Join § Con

,, \ Target Body
. W [y select
MODIFY ~ l 'Join I

Operation




On peut maintenant arrondir cet angle
ainsi que celui du bas.

AN

v

C) Le « haricot » :

Un plan sur le dessus.

Un sketch sur ce plan.

Un cercle de 4 mm de diamétre pour moi,
concentrique avec les précédents donc

« aimanté » par le centre des axes.

~J

Outil « Spline » pour dessiner une ligne
courbe quelconque.

Trés important : Zoomer et bien placer le
début de la spline sur le centre du disque.

Faire un tracé avec 2 ou 3 étapes pour avoir un
ou des points qu’on pourra déplacer par la suite.

Bouton « Stop Sketch » (A @
droite) pour quitter le sketch. STOP SKETCH

Rendre le sketch visible.

L Clic droit sur

I’extrémité / Move.
Sketch1

Sketch2 ,
Et la déplacer.
Sketch3

Sketchd

Sketch7?




Idem pour le ou les points
intermédiaires si on veut
modifier la courbe.

Q? G @ ﬁ Outil « Sweep ».

@ / Retour 2 la liste
Eﬁ New Compoyn /

T Extrudi/ E -
& Revolv /
@ Sweep I

| @ SWEEP
. . Type 02 Single Path -
Le disque comme profil.
T [> 1selected X
iy
/[ La lighe comme trajet| cnanseecton

Distance 1.00 -
Taper Angle 0.0 deg v
Twist Angle 0.0 deg -
Orientation R4, Perpendicular -
New body —— .. | m
;) [ ok | [ cancel |

Outil « Filet » pour arrondir
le bout.




(@ berct landais vi_[O) Si on veut modifier sa forme :

4 9
D £ Document Settings Repérer le sketch concerné (Clic sur chacun)
E %’ ;"’“’V’e“ / Puis clic droit / Edit Sketch
Origin
D @ EJ Bodies
4 Q 1,55,
@ [ sketent
@ [ sketch2
@ {2 sketcn:
@ [E] sketchs B
| (O T—
49 B @
Q [iﬂ Offset Plane
% 'ﬁl 2 st Sketen | STOP SKETCH ¥
Clic droit / Move Ou sur Puis quitter le
Sur un point de la courbe I'extrémité Sketch

[iﬂl:m@[iﬂl:mTGﬂBG@@@@@@@GﬂE@@T [

On peut aussi repérer le sketch dans la barre « Historique » et double-cliquer pour modifier.

L’historique permet aussi de revoir toutes les étapes de la création :

4« »[»] ¥ Bow B STy e a0 E

Clic pour revenir au début. Puis clic ici pour revoir une étape a la fois dans la création.

D) Le bas du corps :

Idem que le béret :

Créer un disque plus bas que le
cylindre.

/

_— Puis outil « Loft » pour faire la jupe.

Retour a la liste

——— Réunir les 2 bodies en un seul body (Outil
« Combine / Join »)

\ Sinon on ne pourra pas faire I'arrondi ici.




T Outil « Filet » pour faire ces 2 arrondis.
—

E) Le bras droit :

Sélectionner le cylindre. Un plan est créé sur la
Outil « Tangent Plane » tangente du cylindre a 'endroit ot on a cliqué.

\é
&g
CONSTRUCT ¥
(J) Offset Plane
{&p Piane at Agple

& Tangent Plane

=)

2.

Sélectionner le plan en cliquant dessus. Puis « Sketch ».
Utiliser I'outil « Spline »

Sur le plan tangent créé sur le cylindre, faire
un Sketch.

Sur ce sketch, un disque dont le centre est
sur I’axe (Donc aimanté sur cet axe).

Outil « Spline » pour créer cette courbe.
Avec un point (étape) créé lors du tracé.

«— Et un point d’arrivée @

Puis quitter le sketch. —— | srop skercii~

W [J Bodys o
4 Q B Skeiches Rendre le sketch visible. Retour a la liste
@ [ sketcht
Q B Sketcn A savoir : Ici il s’agit d’'une méthode assez simple pour
= créer les bras. Mais je vous conseille plutot d’essayer la
@ [ sketcns création avec SCULPT. Pas compliquée non plus !
Q@ [£] sketchs Voir le tuto complémentaire :
@ [ sketen? / "% Création des bras avec SCULPT.pdf
@ [&] sketchs




Clic droit sur le point
du bout / Move.

Le déplacer pour
I’éloigner du corps.

Déplacer de la méme

facon ce point étape—]

de la courbe.

Outil « Create / Sweep ».

isque comme profil.

gne comme trajet

N

I| @ SWEEP

\ 0= Single Path
Profile [y 1selected %

(La main sera faite a la fin du tuto)

New body
S~

= & 1 selected B

Chain Selection

Distance 1.00

Taper Angle 0.0 deg

Twist Angle 0.0 deg
\WA h& Perpendicular

Operation

(] oK

Cancel

(On en voit une version sur certaines captures mais elle est obsoléte)

F) Le bras gauche :

Comme précédemment, placer un plan tangent.

Puis un Sketch.

/

Dessiner un cercle et une courbe avec I'outil Spline.




Quitter le Sketch.
Rendre le Sketch visible.

/ Ecarter les points du corps.

A savoir : Ici il s’agit d’'une méthode assez simple pour
créer les bras. Mais je vous conseille plutot d’essayer la
création avec SCULPT. Pas compliquée non plus !

Voir le tuto complémentaire :

% Création des bras avec SCULPT.pdf

- \ Outil « Create / Sweep »

G) La ceinture :

Retour a la liste

/

Sélectionner cette face.

Nouveau plan que I'on place a cette hauteur.



@ Press Pull ; Q

==/

Rule Fillet
@ Chamfer
Shell
@ Draft
Scale

/

| Spiit Body |

Outil « Modify / Split Body »

Le body a couper

L’outil de coupe :\
e Splitting Tool

Le plan créé

4 Q £, Constuction,,
=L
&
=L
[E1 Plane16

Plane1
Plane2
Plane3
Planeé
Plane7
Plane13
Plane14
Plane11
Plane12 2
Plane8 ,\&)
Plane9 LI
Plane10
Planed
PlaneS
Plane1

QO OO DD DD O DD D O D D D

© SPLTBODY
[} select

Extend SpiitingTool &

;] [[ox ]

© SPLITBODY INFORMATION

Cancel |

On obtient 2 bodies.
\\

Idem pour
~ refaire un
nouveau plan

un peu plus ™~

haut.

Méme outil
« Split Body ».

Coupé | —




L~ 2 mm.

Sélectionner la ceinture.

Outil « Modify / Scale /

/Uniform ».
Et lui attribuer une échelle de

1,05.

On I'a fait ainsi déborder du

A savoir :

Apres 'impression, on
se rendra peut-étre
compte que certaines
valeurs sont a
modifier.

corps pour la mettre en relief.

Outil « Modify /
Filet ».

Créer un arrondi de

H) Les pieds .
Retour a la liste
D QBM“\ Rendre invisibles :
D @ B3 Canvases — Pas le groupe de bodies ! 4 9 L. Bedss..
D @ E3J sketches Mais les principaux a @ [ Body2
DW I'intérieur. = @ () Bodys
D O (J&@ Mt | Tout le groupe Construction Q@ @ Booys

Ceci pour mieux voir notre dessin.

Ne pas rendre invisible tout le dossier « Bodies » sinon on ne verra pas I’extrusion.

Importation d’'une image qui servira de modele :

(Cette image est fournie dans le ZIP)

INSERT ¥

/ Attached canevas.

© ATTACHED CANVAS

Select Image

Canvas opacity
Display Through
Selectable Q

Choisir le plan sur lequel on veut la placer.

(@) e— Aller chercher I'image.

o~

g

“

d

—— Le choix d’une opacité par défaut est tres bien.



Sketch.

On a maintenant un sketch qu’on

peut extruder pour créer un

élément en 3D.

Rendre le canevas invisible.

p ——
4 9 ,

Extruder les 2 pieds en méme temps.

Renommer les 2 bodies en « Pied 1 » et
« Pied 2 » (Ce que j’ai négligé dans les
phases précédentes de ce tuto, mais qui
facilite le travail ensuite).

L Clic droit / Move

L

Rotation de 90°.
Idem pour le 2¢™e pied.

Passer en vue « Right » ~,

Outil « Spline ».

RIGHT

~N

Faire le dessin des 2 pieds avec
I'image en arriere-plan.

Puis « Stop Sketch » pour quitter le

Retour a la liste




Outil « Modify / Scale ».

4 Etattribuer a chacun

une échelle de 1,8.—> ’ 7 ‘

© SCALE Outil « Modify / Scale ».

Entties X _ De type « Non uniforme » pour n"augmenter que la hauteur.
Point [y 1 selected X / ~

X Scale 1.00 v

Y Scale 1.00 - .

ZScale 1.00 < =

(i ] oK Cancel

© SCALE INFORMATION = - —— —_— =

Outil « Modify / Filet ».

Ne sélectionner la ligne que
sur un pied a la fois.

Retour a la liste

Créer un arrondi avec I'outil

/ « Modify / Filet ».
\

MODIFY




1) Les 2 jambes :

Sélectionner le dessous du pied. Outil « Cercle avec centre » et dessiner un cercle.

Idem pour le 2&me
pied.

Stop Sketch.

© EXTRUDE
Start | Profile Piane v

bt : Outil « Extrusion ».
Extent H Distance v

Dist: -21.00 v

Fee - « New Body ».

Sélectionner le disque.

@

STOP SKETCH

/

Stop Sketch.

Taper Angle 0.0 deg /
Operation - Idem pour l'autre

pied.

B ) OK Cancel

A -

J) Les 2 jambes de pantalon :

Retour a la liste

Sélectionner cette face.
Outil « Cercle avec centre ».
Dessiner 2 cercles plus larges que les jambes.




Sélectionner les 2 disques.

En utilisant la touche « Maj » car il y a plusieurs
morceaux a sélectionner en méme temps pour
avoir les 2 disques entiers.

« Symetric » pour que I'extrusion se fasse
dans les 2 sens.

© EXTRUDE
Profile R 2 selected B4 O .
util
Start }-’ Profile Plane v

« Extrusion ».

Direction M Symmetric v
Measurement fuall 3 \
-

~~ Symetric.
Distance 6.00 mm
Taper Angle 0.0 deg v

- New Body.
Operation /
(i ] 0OK Cancel

Clic droit sur le Body de la jambe / Move.

_— Et faire une rotation.

Idem pour l'autre jambe.

On peut créer une différence de position en hauteur
entre les 2 jambes de pantalon.

Outil « Create / Filet ».

Créer un arrondi.

/

Retour a la liste




K) Mettre la ceinture de biais : S ——

|

Clic droit sur le Body /
Move.

Rotation de 2 degrés.

Pour combler I'espace
créé :

Outil « Scale / Non
uniforme » pour

hauteur du corps.

L) Le nceud :

_ En

B @ Boduz
Q o Pied +§-t Move/Copy

augmenter légerement la

d

Sélectionner la ceinture.
Outil « Tangent Plane ».

cliquant ici.

(1- e,

Plane at An
Tangent Plane

Sélectionner le plan.
Sketch

——— Puis Cercle.

Sélectionner le disque.

_— Extrusion.

Outil « Modify / Filet ».
Créer un arrondi.




Sélectionner cette face.
Placer un plan d’angle.

En cliquant ici.
([Ic¥e

« -40 degrés ». (B offset Plane

ﬁ) Plane at Angle ]

Sélectionner le plan.
Sketch.
Puis créer un Cercle.

Sélectionner le disque.
Extrusion / New body.
Repositionner ce body
(Move) si nécessaire.

Outil « Spline ».

Dessiner 2 Splines :

\ L'une qui part du centre du cercle.
L'autre qui part du cercle lui-méme.

Stop Sketch.

Retour a la liste

Un peu difficile ! Patience !

Déplacer, ensuite, chaque point pour
obtenir une forme harmonieuse

(Bien vérifier en se déplacant dans tous
les sens dans I’environnement 3D)

S’arranger pour que les 2 splines se
rapprochent en bas (Ce sera la pointe
du noeud).




Retourner dans le Sketch si la forme ne plait pas.

Pour cela :

Double-clic sur I'icone du Sketch dans la barre de I'historique en bas d’écran.
A la fin : Stop Sketch.

Pour la suite : Rendre les 2 Sketchs visibles car on doit voir ces 2 splines
(Pour cela : L'ampoule dans I'arborescence)

@ SWEEP

Type

Profile

Path

Chain Selection
Orientation

Operation

Single Path

0= Single Path

@ Path + Guide Rail |

§2 Path + Guide Surface

h& Perpendicular

[j New Body

Outil « Create / Sweep ».

—— Choisir la version « Path + Guide Rail ».

Retour a la liste

. © SWEEP
Le profil est fe 4

que Type (03 Path + Guide Rail -

Le trajet est la spline du centre =

Guide Rall [y select

- i du bord Chain Selection &)
Le guide rail est 1 spline
Extent (L2 Perpendicular to Path v
Profile Scaling Scale -
:
New body —— (@seweons |

(i} Cancel

On peut souhaiter
I’avoir plus pendant.

Dans ce cas, joindre les
2 éléments en un seul
body.

Puis « Move »
(Rotation et déplacer)




M) Les yeux :

Outil « Create / Sphere ».
Accepter le plan proposé donc cliquer dessus.

Dessiner la sphére sur le coté. Diametre 6 mm
par exemple.

« Clic droit / Move » et le positionner a peu prés a I'endroit voulu.

@ () Body2s Le dupliquer :
Q m «— Dans I'arborescence, copier / coller ou « Ctrl + C » « Ctrl +V ».

On a alors les fleches qui permettent de tout de suite déplacer la copie.

@ MOVEICOPY

Move Object  [] Faces -

Selection k1 selected B9

Move Type . B B e

Set Pivot it

X Distance 0.00 mm v

Y Distance 0.00 mm v
[ zostance  200mm | =

XAngle 0.0 deg -

Y Angle 0.0 deg v

ZAngle 0.0 deg -

\
Pour des déplacements précis, la seule solution est de taper une valeur dans la fenétre, le déplacement
au curseur n’étant pas assez fin.

Retour a la liste




N) La bouche :

A) Le dessin est simple, on peut donc adopter cette méthode :

Bien se positionner
face a I'endroit voulu
pour la bouche.

__ Clic sur la téte a
I’endroit voulu.

« Construction / /

Tangent Plane ».

Sélectionner le plan.

Prendre I'outil « Spline » ou mieux, pour ce dessin, |'outil
« Arc 3 points ».

Et dessiner les 2 arcs de cercles.

Stop Sketch.

Outil « Create / Extrusion ».
Pour le profil clic sur

© EXTRUDE ~ le dessin créé.
Profile [ 1selected X

Start L'H From Object \'

Object . . .
= ™ Choisir Start : « From Object »
Offset 0.00 mm v
Direction h One Side v A savoir :
Extent -l istance % ai de 2 Si I’extrusion est refusée, c’est
(ostance  2om }— —» Onfaituncreuxde2mm. | o000 qil faut mettre une

valeur négative donc « - 2 mm »
(Parce qu’ici on est a droite de la
téte et que I’extrusion se fait vers
» Objects To Cut la gauche).

Taper Angle 0.0 deg . ..
Pour faire un creux, choisir

Operation — « Cut ».

Il reste a sélectionner |'objet de
départ de I'extrusion :

Cliquer sur la téte.

L’extrusion va commencer sur elle
(Et va méme épouser sa forme
arrondie). Retour a la liste

On voit déja le creux qui sera créé.

Donc « Ok ! ».



B) Si le dessin avait été plus complexe, il aurait été préférable d’'importer une image a copier :

7 Ccanvases

]

Sketches

VOO DD
© (©)o © (9]

O 67 Main v2:1

Rendre invisibles :

™~ Pas le groupe de bodies !
Mais les principaux a
I'intérieur.

— Tout le groupe Construction

Ceci pour mieux voir notre dessin.

4 7 [, Bodes,,
@ () Body2
T G D Body4
@ () Bodys

Ne pas rendre invisible tout le dossier « Bodies » sinon on ne verra pas |'extrusion.

N

INSERT ¥

© ATTACHED CANVAS

Face R 1selected B4

Select Image
Canvas opacity S0

DisplayThrough [

Selectable (.

/ Attached canevas.

-

__ Aller chercher I'image JPG.

Le choix d’une opacité par
défaut est tres bien.

Choisir le plan sur lequel on veut la placer.

//

Outil « Spline ».

Faire le dessin avec I'image en

arriére-plan.

Puis « Stop Sketch »
Sketch.

pour quitter le

On a maintenant un sketch qu’on peut extruder pour créer un élément en 3D. Donc un

body.

Rendre le canevas invisible.

Origin

AT DD

Canvases

Retour a la liste




soomm v |4

Déplacer le body
de cette bouche
(Clic droit / Move)

pour le positionner
au mieux devant la

téte.
I

Utilisation de cet « outil » pour créer le creux de la bouche sur la téte :

Outil « Create / Extrusion ».

Le profil est la face

qu’on sélectionne ici. \

= Choisir Start : « From Object

»On fait un creux de 2 mm.

Operation

P Objects To Cut

© EXTRUDE -
Profile [s 1 selected X ]/
Start |+ From Object \v
Object
Offset 0.00 mm I v
Direction B2y one side -
Extent H Distance v

[ Distance 2mm }7
Taper Angle 0.0 deg

Pour faire un creux, choisir
« Cut ».

A savoir :

Si I’extrusion est refusée, c’est
parce qu’il faut mettre une
valeur négative donc « - 2 mm »
(Si on est a droite de la téte et
que l'extrusion se fait vers la
gauche).

Il reste a sélectionner |'objet de

départ de I'extrusion :

Cliquer sur la téte.

arrondie).

Donc « Ok ! ».

L’extrusion va commencer sur elle
(Et va méme épouser sa forme

On voit déja le creux qui sera créé.

Retour a la liste




Touche « A » du clavier pour
/ 7 .
mettre un matériau.

Pour que la bouche ne soit pas
jaune, attribuer le matériau
dans le dos.

O) Les mains :

On va utiliser une technique particuliére.
Les 2 mains seront créées dans un fichier « Fusion 360 » spécifique.
Et on les utilisera, ensuite, dans notre fichier de création du personnage.

1) Version « Mains raides » :

Sketch
2.5 & b

SKETCH ¥
e —

Choisir de le faire sur le plan vertical

Create Sketch
.o Line
Rectangle

avec centre

/ Cet outil Cercle
\‘ @ Center Diameter Circle I C‘
3

O 2-Point Circle

Je ne donne pas de dimensions puisqu’on pourra modifier I'échelle des mains trés facilement a la fin.
Le principal étant de réaliser un ensemble harmonieux.

On peut, pour simplifier, créer une main avec des cylindres comme ceux-ci :

Donc extrusion du
disque créé
précédemment.

Faire des copies et

B rapprocher les 3
doigts qui rentrent un
peu I'un dans 'autre.

Retour a la liste




Ajout d’un pouce placé en biais (Contrairement a cette capture, il faut le faire plus gros que les doigts).
|

La paume de la main est une copie d’'un /
cylindre également. \

Puis outil « Modify / Scale / Non
uniforme » pour lui donner cette
section ovale. \ Arrondir les arétes avec I'outil « Create / Filet ».

Dans le méme fichier, en faisant des
copies et des rotations, on peut créer
cette main pouce en lair.

/

Retour a la liste

Lorsqu’on est satisfait de ces 2
créations, faire des copies du fichier.
— Mais dans chacune des 2 copies, ne
// conserver gu’une seule main.

lg Main raide G l

[ Main raide D




Document Settings

&

EJ Named Views
@
@

A4

Dans chacun de ces 2 fichiers, regrouper les
5 bodies en un seul body :
Outil « Create / Combine » / Join.

© COMBINE
Target Body
Tool Bodies

Operation

New Component

[ select

o

@ (@) Mainraide D

D @ EJ Sketches

Les 2 mains de ce type sont fournies dans le zip.
On peut ainsi réaliser cette version du personnage.

Retour a la liste

2) Version « Mains courbes » :

Ig_ﬂ_ | — Sketch

@ Create Sketch

m -2 Line
k Rectangl »

@ Center Diameter Circle C ]

3y Elincg

G —
Arc »
Polygon »

O 2-Point Circle
(> 3-Point Circle

Choisir de le faire sur ce plan vertical — |

Créer un
cercle de
diametre
22 mm.




— Faire pivoter le cube de l'interface.

i — Et clic sur « Top » pour chaisir la vue de haut.
Si on place le curseur dans la zone on repeére le
disque créé. On ne voit que la tranche.
O

t ¥— On peut légerement pivoter la vue vers l'arriere
pour apercevoir le centre du cercle.

v Outil « Spline ».
Créer une spline.
La dessiner Important : Le point de départ

doit étre parfaitement sur le
centre de cercle.

parfaitement rectiligne
(On est aidé par I'axe).

Avec un point intermédiaire.

Important : Tres petite ! ) .
Et un point d’arrivée.

Touche « Echap » pour quitter I'outil « Spline ».

AIGHT | ¢+——— Se placer en vue « Right ».

On apercoit le disque.

/ Et la Spline avec ses 3 points.

Retour a la liste




Clic droit sur le point intermédiaire de la Spline /
Move.

/,-—4
= il
f‘// Et le déplacer en le positionnant plus en face du
@O disque.

ot Faire de méme avec le point du bout de la Spline.

Environ 2,5 fois le disque

&
<

Le but est

d’obtenir ce dessin
“— (Avec les mémes

proportions).

@ <«— «Stop Sketch » pour quitter le Sketch.

STOP SKETCH ¥

En pivotant légerement dans
«— lavue, on obtient ceci.

© SWEEP

Type 0= Single Path v

Profile R 1 selected [ S—

Outil « Create / Sweep ».
Le profil est |e disque

Orientation h& Perpendicular -

Operation Cﬁ New Body v
ix

(i} Cancel

Path [y select
Chain Selecton @ \ Le t

raj,
/et egt la splin
e

Retour a la liste

« New Body »




D ﬂ' Document Settings
D EJ Named Views
D @ B3 origin
4 Q [, Bodes,,

?
D @ EJ Sketches

Retour en vue « Top ». —

(ME®M @ Mains courbes v2 [O]

copier.

D @ EJ Sketches

«Ctrl+V»p

ol
EJ  Named Views
@

— «Ctrl+C»p

|__— Nouvelle copie qu’on écarte des
3 doigts.
Ce sera le pouce.

| Clic droit surle nom du
body / « Ctrl + C » pour

our coller.

_— Puis déplacer la copie.

our copier.

« Ctrl + V » pour coller.

— Puis déplacer la copie.

Retour a la liste




] Retour en vue « Right »
RIGHT | ] g
7 si on l'avait quittée.

Cré Choisir ce —
7| «— Créerun lan.
| Sketch. P

]
a

__ Sélectionner le
disque /
Extrusion (New ——
- Body)

P
&

————— Créer un cercle de 22 mm

de diametre.

)
O
°

Le déplacer.
Attention ! Si
on fait « Clic
droit / Move »
ici

On déplace son

centre. \

U
& o

Il faut faire le « Clic droit / Move » sur son
nom dans |'arborescence.

Et on a bien les poignées adaptées|pour son
A déplacement.

4 Q £, Bodes,,
@ [ Booyt
Q@ @ sody2
Q@ @ Boays
@ () Bodys
Q




Le positionner ainsi.

Outil « Modify / Scale »
Non uniforme /

© SCALE
Entities X
Point [3 1 sele x
X Scale 1.00 v
¥ Scale 1.00 -
ZScale 1.00 v

Se mettre en vue « Top ».
Et déplacer I'élément pour le coller
aux doigts.

Retour a la liste

Outil « Create / Filet ».

__—Sélectionner ces lignes avec la
touche « Maj ».




Déplacer les
éléments, faire une
rotation du pouce
pour obtenir ce
résultat presque
final.

L~

[ R —

[
—‘O

Main courbe D

Body1
Body2

afajajala s}
§

[N
)

O DD 0D D

U O O 0 D V0|

o

odies

e

.
.

Main courbe D

O
g
3

ody2

a|a|a|ala
] g g [+
HE

ody5

créer I'arrondi.

—— Utiliser la fleche-curseur pour

Outil « Modify / Scale »
Non uniforme.
Pour grossir le pouce.

Clic droit sur le dossier « Bodies » /

¥—— « New Group » pour créer un nouveau groupe
gu’on nomme par exemple « Main courbe D ».

Touche « Maj » pour sélectionner les 5 éléments.
Puis les faire glisser dans le nouveau groupe.

Puis le repositionner Iégerement.

Retour a la liste




4 Q . 5Bodss,, Clic sur le nouveau groupe. « Ctrl + C» « Ctrl +V ».
D

(B 5 Main courbe D (5)

4 3 F, Bodes,,

@ B3 Main courbe D (5)
@ £, Maincourbe D (1) (5),

e

@
D - Une copie du groupe est créée.
D

Les curseurs sont disponibles
pour la décaler.

_ On peut rendre invisible le groupe original
(Ampoule dans I'arborescence) pour se
concentrer sur cette main.

\
A Q*D Bodies
DD Main courbe D (5) Renommer la
D @ B3] MainpouceD (5) nouvelle main.

___— Choisir la vue « Back ».

8

‘ ' Retour a la liste
A A 4 4 BACK

- Touche « Maj » et sélectionner
Q FoL. MainpoussD(5), les 5 éléments dans le groupe.

=2 » Clic droit / Move.

Q Faire une rotation de 90°.
Q

@ Body10 /




Faire une
rotation sur le
pouce et le

— repositionner.

Faire aussi une
rotation surla —_
vue « Top ».

_—

Outil « Modify / Scale » Non uniforme.

50deg |~ [

Il faut, maintenant,
réduire les doigts.

Puis « Move »

Réduire

On obtient une main droite
— pouce levé.

On voudrait, maintenant, avoir
I’équivalent en main droite.

Retour a la liste




Conseil : On va devoir regrouper le pouce, la paume et les 3 doigts en un seul body pour exploiter la
main ailleurs.

Je conseille, tout de méme, de conserver une version « non groupée » pour pouvoir modifier la main
ultérieurement si nécessaire. On va donc procéder comme ci-dessous.

4 )

Original ___ Copier le groupe de cette main.

‘_ - « Ctrl + C » puis « Ctrl +V ».

Original _ Déplacer la copie en —dessous.

\ Faire la méme chose pour l'autre
~~ main créée.

/ \ — l 4 Q B3] MaincourbeD (5)
o Pour 'original, conserver Q @ Bouyt
Original les bodies séparés. Q@ Boay2
—
@ ([ Bouys
..... - Original @ ([ Booys
@ ([ Bouys
4 9 . Mainsoubed0)6),
Pour la copie, faire Q Outil
un seul body. » © — 1 «Modify/
_ . v i Combine »
S Cove v Join
Q /
4 Q B3 Man courbey()ﬁ)
@ () Bodyn

Sélectionner la main droite. La main gauche est créee !

Outil « Create / Miror » \
Cliquer ici pour qu’il propose un
plan servant de miroir.

Choisir le plgh vertical.

© WRROR
\a.memT\ype (2) Bodies -
Objects [y 1selectf X \ :
Mirror Plane |
1

[ ) 0 | Cancel ~N——-




Méme procédé pour I'autre type de main créé :

Il s’agit, maintenant, d’étre organisé car on va faire des copies de fichiers pour avoir des mains isolées
utilisables ailleurs ou qu’on peut méme partager avec d’autres (Comme les fichiers que je vous fournis).
Personnellement, je décide que tous ces fichiers complexes avec une collection de composants, je les
organise sur la vue « Front ».

N | o ‘ Retour a la liste

Et je dispose mes mains ainsi :

Originaux avec les éléments
non groupés en seul body.

| Cette main en versions droite
et gauche regroupée en seul
body.

— Cette main pouce levé en
versions droite et gauche
regroupée en un seul body.

Ne pas oublier d’enregistrer ce fichier a ce stade ! ‘
Un peu long. Patienter | ——mHoH__ = t

@ Mains courbes

\_ J

Le probléme qui apparait : On ne peut pas isoler la copie faite avec I'outil « Create / Miror » seule dans
un fichier car elle possede une contrainte qui I'oblige a rester liée a son original.
Il faut donc, pour y parvenir, transformer son body en composant.

4 Q £, Bodies,,
o [T «— Clic droit sur le body /

Q C tEO Move/Copy M
o3 « Create Components from Bodies »
[> e 5 [= Move to Group /

E Create Components from Bodies ]




4 Q B Bodies
@ () Bodyts
D @ E1 Sketches

AI @ O Component2:1 ]O .
b 0% - Il est maintenant devenu un composant dans le

4 Q E] Bodes dossier des composants.

GO =)~

Le body a disparu.

4 9 @ Main gauche courbe v1
D 8 Document Settings Remplacer le nom « Component » par le nom de la
D EJ NamedViews main créée.
D @ E1 oOrigin Activer ce composant (Clic dans le petit rond).
D & E3J Sketches <
WRCH @ Main gauche courbe:t O 4 Supprimer les autres bodies s’il en restait encore.

Dans I'historique, on peut supprimer les

<<« p » p [EEECM mﬂ.%{———- éléments rouges devenus inutiles.

ﬁ « File / Export » pour enregistrer le fichier de ce composant sur
F3D le PC afin de le partager avec d’autres.
Main droite
courbe v2 v4.f3d

Type : Autodesk Fusion 360 File
Taille: 1,63 Mo
Modifié le : 01/07/2018 17:15

Pour exploiter ce composant dans un autre projet :

4 9 ®
D ¥ Document Settings
D EJ NamedViews

D @ B3 orign
@ Main gauche co... \

\ q\\

Clic droit / « Insert into Current Design ». Et il sera inséré au projet en cours (Enregistré au préalable).

/
@
D &£ Document Settings
D B3] NamedViews
D @ E3J origin
D @ B3 Bodies
D @ B3 Sketches
[[) Q@ (b ¢ Main droite courbe v2 vé:1

Retour a la liste




© SCALE

Entities R 1 selected B

Point I3 1selected X

Scale Type E Uniform v
Scale Factor 1.00 v
[i ] OK Cancel

© SCALE INFORMATION

Dans le fichier du
composant, on peut
changer la taille de
la main :

Outil « Modify /
Scale / Uniform » et
~~ clic sur la main.

Puis enregistrer.

11} b
— EEE v
mam

MODEL ~

E ™ v =~

.o HE &

Dans le fichier du
projet, on est

£  Origin
EJ Bodies
E7J Sketches

Falrat

VAV
O O O G

ourbe v2 v4:1

informé que le
___ composant a été
modifié.

Cliquer sur le
N bouton
« Actualiser ».

3) Version « Mains créées a partir d’'une image » :

On peut la créer dans un projet vierge ou dans ce projet en cours.
Je vous conseille de la faire dans un fichier vierge. -
Si on la fait dans ce projet en cours :

Bodies

il

D @ FE3J canvases
D @ E3 Sketches

D (@) &_constncton |
D @ () & wainv21

Rendre invisibles :

™~ Pas le groupe de bodies !

Mais les principaux a @ () Body2
I'intérieur. = @ () Body4
~ Tout le groupe Construction Q O Bodys

Ceci pour mieux voir notre dessin.

Ne pas rendre invisible tout le dossier « Bodies » sinon on ne verra pas I’extrusion.

Importation d’une image qui servira de modeéle :

(Cette image est fournie dans le ZIP)

N

INSERT

© ATTACHED CANVAS

Select Image

Canvas opacity
Display Through

Selectable ()

/ Attached canevas.

(o )e—T Aller chercher I'image.
@ ‘\ Le choix d’une opacité par défaut est tres bien.

// =~

Choisir le plan sur lequel on veut la placer.

Retour a la liste




Passer en vue « Right ». — ’ |

Outil « Spline ».

Faire le dessin de la main avec I'image en
arriere-plan.

Rendre le canevas
invisible.

Dessiner cette spline qui « coupe » le pouce.

Dessiner aussi cette spline qui permettra de /
créer une version « Pouce baissé ».

Puis « Stop Sketch » pour quitter le Sketch.

Outil « Create / Extrusion » / New Body

Faire aussi
I’extrusion du

pouce seul. Largeur :

6,5mm/2=3,2mm

/ /




Faire aussi I’extrusion
du pouce « baissé ».

. Largeur:
6,5mm/2=3,2mm

On a donc 3 bodies : La paume, le pouce levé et le pouce baissé.

Faire une copie de la
paume pour |'avoir
en 2 exemplaires.

— Ne pas mettre
le pouce trop
prés du bord.

Puis outil « Modify /
Combine / Join »

Sinon on sera
tres limité pour

arrondir les
| Pourrassembler le angles avec
pouce et une I'outil « Modify
paume. / Filet ».

Méme méthode
pour la création de
la « Main pouce
baissé ».

—

Retour a la liste




Outil « Modify / Filet » pour créer les arrondis.

Ne pas le faire en une seule phase (On peut mettre par
exemple une valeur plus grande pour le pouce que pour la
paume).

/

Créer, ensuite, 2 fichiers de composants (Méthode expliquée plus haut).

Retour a la liste




